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Introduction 

Purpose 
The User Guide is designed to help users and committees assigned to develop glossary entries approved 
by the National Wildfire Coordinating Group (NWCG).  A glossary entry includes a term and one or more 
definitions for that term.  Within this guide, users can find instruction on understanding the glossary 
process, how to view the glossary on the NWCG website, how to develop a glossary entry, and contacts 
for support.  The User Guide is a living document, and will continue to be updated as the process 
matures. 

The user guide addresses the following areas: 
 Use of the NWCG website for: 

o Requesting new or revised glossary entry. 
o Searching and viewing approved glossary entries. 

 The process and guidance for NWCG committees and subgroups assigned to develop or revise 
glossary entries. 

 Technical requirements for complete glossary entries. 

How to Use This Guide 
The following instructions are for Adobe Reader X.  The steps may vary slightly with other versions of 
Adobe Reader. 

Display the Table of Contents 
You can use bookmarks to quickly navigate to areas of interest.  The User Guide table of contents can be 
displayed in the bookmark navigation tab.  To display the table of contents for this User Guide, in 
Acrobat Reader: 

1. Click the Bookmarks button in the left navigation panel, or choose View > Show/Hide > 
Navigation Panes > Bookmarks. 

2. To jump to a topic, click the bookmark.  Expand or collapse bookmark contents, as needed. 

Navigate with Links 
The hyperlinks in the document will take you to another location in this document or to a website.  To 
go to another location indicated by a hyperlink in Acrobat Reader: 

1. Position your mouse over the link until it turns into a hand symbol.  Click on the link.  The area in 
the document bookmarked by the link will be displayed. 

2. After clicking a link, to go back to the page you just left, reference the steps below to retrace 
your viewing path. 
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Retrace Your Viewing Path 
You can find pages that you viewed earlier by retracing your viewing path.  Use the previous and next 
view in Acrobat Reader as they function similarly to the Back and Forward buttons in your browser.  For 
example if you jump to a place in the guide using either a bookmark or a link in the text, the previous 
view will take you back to the page you just left.  To navigate to a previous view or next view in Acrobat 
Reader: 

1. Choose View > Page Navigation > Previous View. 
2. To continue seeing another part of your path, do either of the following: 

a. Repeat step 1. 
b. Choose View > Page Navigation > Next View. 

  BASED ON YOUR AGENCY’S CONFIGURATION AND BROWSER RESTRICTIONS, YOU CAN ADD THE PREVIOUS VIEW 

AND NEXT VIEW BUTTONS TO THE TOOLBAR BY RIGHT-CLICKING THE TOOLBAR AND SELECTING PAGE 

NAVIGATION AND THEN CHOOSE THEM ON THE CONTEXT MENU, OR CHOOSE SHOW ALL TOOLS. 

Search the Help 
You can use the “Find Text” tool to search the entire document for specific text.  To display the search 
box in Acrobat Reader: 

1. Choose Edit > Find. 
2. Enter your search text in the search box and hit Enter. 
3. The first occurrence of the search criteria will be displayed.  Use the arrows in the search box to 

navigate to the next occurrence of the text.  Consult Acrobat Reader help for further 
information on advanced searching. 

 YOU CAN ADD THE FIND BUTTON TO THE TOOLBAR BY RIGHT-CLICKING THE TOOLBAR AND SELECTING EDIT AND 

THEN CHOOSE FIND. 

Process Diagram Key 
This User Guide includes diagrams to help you understand the workflow and steps involved in creating 
or revising glossary entries.  Please reference the Workflow Diagram Key (page 13) for an understanding 
of the workflow graphics used to represent persons, groups, and objects used in these diagrams. 

NWCG Background 
The National Wildfire Coordinating Group (NWCG) is a collaborative and cooperative partnership of 
governmental agencies, the National Association of State Foresters, International Association of Fire 
Chiefs, and the Intertribal Timber Council with national responsibilities for wildland fire management.  
NWCG was formed to provide national leadership to develop, maintain, and communicate interagency 
standards, guidelines, qualifications, training, and other capabilities that enable interoperable 
operations among federal and non-federal entities. To that end, NWCG has established a number of 
groups in which wildland fire program management issues, both short and long term, can be vetted.  
These groups (which include committees and subgroups) serve to provide the national-level interagency 
coordination necessary to establish, maintain, monitor, and improve the effective and efficient use of 
the nation's wildland fire management resources.  NWCG committees are responsible for stewardship 
over one or more assigned areas of NWCG and wildland fire business. 
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Understanding the Glossary Process 

Why Does NWCG Need to Develop Glossary Entries? 
The NWCG Glossary of Wildland Fire Terminology is developed and published to provide accurate and 
consistent glossary entries that can be used by NWCG in its product development and also across 
agency wildland fire programs. 

 A GLOSSARY ENTRY INCLUDES A TERM AND ONE OR MORE DEFINITIONS FOR THAT TERM.  MOST TERMS ONLY 

HAVE ONE DEFINITION.  HOWEVER, IN SOME CASES A TERM MAY BE USED IN DIFFERING CONTEXTS BY VARIOUS 

BUSINESS AREAS SO MULTIPLE DEFINITIONS ARE WARRANTED. 

Consistent use of terminology promotes the efficient sharing of information, facilitates analysis of data 
from disparate sources, improves data integrity, and maximizes the use of shared resources. 

How Are Terms Developed and Maintained within NWCG? 
NWCG develops and maintains a robust library of wildland fire specific glossary entries that enable the 
common usage of terminology across wildland fire information systems. 

 THE NWCG GLOSSARY IS PUBLISHED ANNUALLY AFTER JANUARY 1.  NEW OR REVISED GLOSSARY ENTRIES ARE 

REVIEWED BY ALL NWCG COMMITTEES AND SUBGROUPS TWICE A YEAR WITH THE LAST REVIEW CYCLE ENDING 

AROUND NOVEMBER. 

Annual publication of the glossary allows committees and organizations responsible for products to 
incorporate changes on a yearly basis.  An NWCG committee or subgroup is assigned as the Glossary 
Stewardship Group to develop or revise a glossary entry.  These groups are the subject matter experts 
and can ensure accuracy of definitions and consistency across agencies. The following entities are 
involved in development and maintenance of NWCG glossary entries; requestor, Data Standards and 
Terminology Subcommittee (DSTS), Glossary Stewardship Group, Internal Reviewers (NWCG committees 
and subgroups), and the NWCG Web Manager. See Figure 3, page 13, for more specific definitions for 
each entity involved in the maintenance of the NWCG glossary. 

The high-level view of the workflow used within NWCG to develop and maintain glossary entries is 
depicted below.

Submit
Request

(Requestor)

Develop
Draft

Glossary Entry
(Glossary  

Stewardship Group)

Receive
Request

(NWCG DSTS)

Final
Review
(NWCG
DSTS)

Publish
Glossary Entry

(NWCG Web
Manager)

Internal
Review
(NWCG

committees and 
subgroups)

Assign Glossary
Stewardship

Group
(NWCG DSTS)

 

Figure 1. Workflow to develop and maintain the NWCG Glossary of Wildland Fire Terminology 
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A requestor can submit a request for a new or revised glossary entry.  The development and 
maintenance processes are shepherded by the DSTS, which assures that all glossary proposals follow a 
standardized development process, are properly vetted, approved, and submitted for publication. 

When a new request is submitted, the DSTS reviews the request and assigns a NWCG committee(s) or 
subgroup(s) as the Glossary Stewardship Group.  The Glossary Stewardship Group is selected based on 
the subject matter expertise required to develop and maintain the glossary entry. 

Glossary entries are not reviewed by the public, but do go through three levels of review within NWCG; 
the Glossary Stewardship Group, NWCG committees and subgroups, and the DSTS.  After all comments 
have been addressed, the draft glossary entry is finalized and approved.  However, terms are not static; 
changes in policy, business requirements, processes, and technology may necessitate changes to the 
glossary. 

The process for revising an approved glossary entry is similar to the new request process, which includes 
careful consideration by the Glossary Stewardship Group, as well as an internal review by NWCG 
Committees and subgroups, and the DSTS.  See Glossary Entry Development Workflow in Appendix A 
(page 15) for more details on the workflow within NWCG for developing and maintaining glossary 
entries. 

How Long Does the Process Take? 
The process for creating or revising glossary entries can vary based on the complexity of the request and 
the Glossary Stewardship Groups schedules.  Glossary entries are sent out for review in the spring and 
fall.  All revisions are incorporated into the NWCG Glossary of Wildland Fire Terminology which is 
published annually after January 1. 

How does NWCG.gov Support Glossary Entry Management? 
The NWCG website http://www.nwcg.gov/pms/pms.htm facilitates the publication and maintenance of 
glossary entries by providing the following capabilities: 

 All users, which include the public, can: 
o View and download the glossary of wildland fire terminology. 
o Submit a request for a new glossary entry or a revised glossary entry. 

  

http://www.nwcg.gov/pms/pms.htm
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Glossary Entry Status 
As a glossary entry is developed or revised, it is tracked by the DSTS and assigned a status.  The status 
indicates the stage the glossary entry is in, from the time the request for a new or revised glossary entry 
is submitted, until the glossary entry becomes approved.  Only approved glossary entries are published 
in the NWCG Glossary of Wildland Fire Terminology.  Contact the DSTS for information about glossary 
entries that may be in the process of being revised. The following table describes each status. 

Glossary 
Entry 
Status 

Status Description 

Requested A proposal for a new or revised glossary entry that has been submitted to the NWCG Data 
Standards and Terminology Subcommittee (DSTS). 

Received A proposal for a new or revised glossary entry that has been received and reviewed by the 
DSTS for validation. 

Assigned A new or revised glossary entry has been assigned to a Glossary Stewardship Group and 
an individual steward as the Glossary Steward Point of Contact (POC) within that group for 
drafting. 

Internal 
Review 

The draft glossary entry is being reviewed by all committees and subgroups of NWCG. 

Final 
Review 

The draft glossary entry is going through a final review by the DSTS before being approved 
for publishing. 

Approved The glossary entry is approved and is published in the NWCG Glossary of Wildland Fire 
Terminology. 

Archived The glossary entry is made a historical record and is no longer in use. 

  



User Guide for Development and Maintenance of NWCG Glossary of Wildland Fire Terminology 4/25/2014 

PMS 937 May 2014 Page 8 

How to View Glossary Entries on NWCG.gov 

View Glossary Entries 
The NWCG Glossary of Wildland Fire Terminology provides an extensive listing of approved terms and 
definitions used by the NWCG community.  It contains terms commonly used by NWCG in the areas of 
wildland fire and incident management and is not intended to list all terms used by NWCG groups and 
member agencies.  The NWCG has directed that all committee and subgroup product glossaries be 
based upon the NWCG Glossary of Wildland Fire Terminology for the purpose of maintaining definition 
consistency and clarity among documents. 

Quick Steps to View the Glossary Entries (terms and definitions). 

1. Go to http://www.nwcg.gov/index.htm. 
2. Click the Publications link on the left-hand side of the top menu bar. 
3. Click the Glossary of Wildland Fire Terminology button. 
4. Click the Approved Glossary link. 
5. Find a glossary entry by browsing through the list alphabetically by the first letter of the glossary 

term. 

Download the Glossary of Wildland Fire Terminology 

Quick Steps to Download the Glossary. 

1. Go to http://www.nwcg.gov/index.htm. 
2. Click the Publications link on the left-hand side of the top menu bar. 
3. Click the Glossary of Wildland Fire Terminology button. 
4. Click the Approved Glossary link. 
5. Click the download complete glossary link on the Approved Glossary page. 
6. Once the file (825 KB) opens in Acrobat Reader, choose File/Save As to save a copy to a local 

drive. 

  

http://www.nwcg.gov/index.htm
http://www.nwcg.gov/index.htm
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How to Submit a Request for a Glossary Entry 
The requestor needs to consider several issues before proposing a new or revised glossary entry.  The 
requestor should answer the following questions prior to submitting a request for a new or revised 
glossary entry (glossary term or definition). 

Pre-work Checklist How do you find out? What does that tell you? 
 Does the glossary term 

already exist within the 
NWCG Glossary of 
Wildland Fire? 

Search the NWCG Glossary of 
Wildland Fire Terminology to 
determine whether the term and 
the appropriate definition is already 
published. 

You can use the term. 

 If the glossary term 
exists within NWCG, 
does it need revised to 
meet my needs? 

View the term and its definitions to 
determine if it accurately represents 
the current wildland fire policy and 
business processes. 

If the term is not defined 
accurately, then submit your 
request as a revision to the 
existing term. 

 If the term does not 
exist within NWCG, then 
does the term exist 
within another agency’s 
glossary? 

Contact other professional 
organizations or government 
agencies that you think may also use 
the term or search the internet. 

If you find a similar term in a 
glossary or publication outside 
of NWCG, submit your request 
specific to wildland fire, but 
include documentation 
referencing the term’s definition 
as used by other agencies or 
professional organizations. 

How to Find the NWCG Glossary Request template 
Quick Steps 

1. Go to http://www.nwcg.gov/pms/pubs/glossary/request.htm  
2. Download the NWCG Glossary Request template.  Instructions for completing the template are 

on the last page. 
3. Submit the completed request to BLM_FA_NWCG_DATA@blm.gov. 

Sample NWCG Glossary Request 
On the same page referenced above, the sample Glossary Request shows a correctly completed request. 

Contact Requestor for More Information 
Once the request has been submitted to BLM_FA_NWCG_DATA@blm.gov, the DSTS will review the 
request and contact the requestor by email or phone if they feel they need more information to clearly 
understand the proposal. 

The workflow process for submitting a request to create, revise or update, or delete a glossary entry is in 
Appendix A, page 15. 

http://www.nwcg.gov/pms/pubs/glossary/request.htm
mailto:BLM_FA_NWCG_DATA@blm.gov
mailto:BLM_FA_NWCG_DATA@blm.gov


User Guide for Development and Maintenance of NWCG Glossary of Wildland Fire Terminology 4/25/2014 

PMS 937 May 2014 Page 10 

How to Develop a Glossary Entry  

Assigning a Glossary Stewardship Group 
Once the DSTS receives the Glossary Request and determines that it is valid, the DSTS in consultation 
with the branch coordinators (BC) determine the committee(s) or subgroup(s) best suited to act as a 
steward for the glossary entry based on subject matter expertise required.  The NWCG committee(s) or 
subgroup(s) selected as the steward are called the Glossary Stewardship Group (GSG).  In addition, a 
Glossary Steward point of contact (POC) will be assigned.  The Glossary Steward POC will be responsible 
for managing the development of the draft entry within the GSG. 

The NWCG Glossary Request and any research the DSTS can provide will be forwarded via email to the 
Glossary Steward POC so the GSG can begin the work of drafting the glossary entry. The workflow 
process for assigning a GSG is shown in Appendix A, page 15. 

Developing a Glossary Entry 
The Glossary Stewardship Group is responsible for developing or revising the glossary entry.  The 
Glossary Steward POC is responsible for managing the process for developing the draft within the GSG.  
Their duties include distribution of information, task assignments and scheduling.  The DSTS is available 
to provide support and guidance to the GSG in developing the draft.  The DSTS will email an NWCG 
Glossary Request to the Glossary Steward POC.  This email initiates the process for a GSG to begin 
developing or revising a glossary entry.  Supporting documents may need to be included in drafting the 
entry such as source references, change management process, or discussion papers.  The DSTS will 
provide the initial research for new terms as a starting point for the GSG. 

Once the definition is drafted, the GSG needs to make a final determination that the definition is ready 
for internal review.  Once that determination has been made, the Glossary Steward POC emails the 
updated Glossary Request (plus any supporting documents) to the DSTS indicating the glossary entry is 
ready for internal review. The workflow process for developing a draft glossary entry is shown in 
Appendix A, page 15. 

Conducting Internal Review 
After receiving the draft glossary entry from the Glossary Steward POC, the DSTS coordinates with the 
PMU to produce an annotated summary of all proposed glossary entry changes that have been drafted 
since the last review period.  The summary of proposed changes, supporting documentation, and 
comment form are emailed to each of the NWCG committee chairs.  Instructions for interpreting the 
annotated glossary review report and recording comments are included in the email.  The workflow 
process for conducting an internal review is shown in Appendix A, page 15.  Figure 2 is a sample of the 
annotated glossary review report with explanations describing the different sections of the report. 
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Figure 2. Sample Annotated Glossary Entry Review Report 

Final Review, Approval and Publishing 
The NWCG Program Management Unit (PMU) will collect and synthesize the NWCG Glossary Entry 
Change Review Worksheets.  For those glossary entries that have comments regarding a drafted entry, 
the DSTS will forward those to the appropriate Glossary Stewardship Group.  The Glossary Stewardship 
Group is responsible for evaluating all comments, formulating responses to the comments, and making 
updates to the draft glossary entry based on comments as necessary. 

The NWCG Glossary Request should continue to be updated as necessary by the Glossary Stewardship 
Group to reflect any updates to the draft.  Once the comments have been addressed, the Glossary 
Stewardship Group determines that the glossary entry is ready for final review by the DSTS.  The 
Glossary Steward POC should forward the NWCG Glossary Request and any supporting documentation 
to the DSTS at BLM_FA_NWCG_DATA@blm.gov indicating the entry is ready for final review. 

In order to ensure all proposed glossary changes are supported by all stakeholders, the DSTS will send 
the revised draft of each glossary entry to the dissenting committee(s) to get their approval.  

The DSTS will synthesize all the unanimously approved glossary entry changes from the review cycle and 
conduct a final review of the new or revised glossary entries before they are approved for publishing.  
This final review is focused mainly on technical editing of the proposal and not on content.  Once the 
final review is complete, the DSTS coordinates with the PMU to document that the new or revised entry 
has been approved for publishing.  After the last review cycle of the calendar year the DSTS will work 
with the PMU to generate a new NWCG Glossary of Wildland Fire Terminology.  The new glossary will be 
posted to the NWCG website after January of each year. The workflow process for final review, 
approval, and publishing is shown in Appendix A, page 15. 

mailto:BLM_FA_NWCG_DATA@blm.gov
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Contacts 
For support and guidance in glossary development or maintenance contact: 
BLM_FA_NWCG_Data@blm.gov or contact any DSTS member: 

Roshelle Pederson, Co-chair, Kimber_Pederson@ios.doi.gov 
Kathie Hansen, Co-chair, Kathie_Hansen@nps.gov 
Vacant, Equipment and Technology Branch Coordinator 
Elaine Waterbury, Planning and Management Branch Coordinator, ewaterbury@blm.gov 
Tim Blake, Preparedness Branch Coordinator, tblake@blm.gov 
Deb Fleming, Training Branch Manager, dlfleming@blm.gov 

mailto:blm_fa_nwcg_data@blm.gov
mailto:Kimber_Pederson@ios.doi.gov
mailto:Kathie_Hansen@nps.gov
mailto:ewaterbury@blm.gov
mailto:tblake@blm.gov
mailto:dlfleming@blm.gov
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Workflow Diagrams 

Entities Involved Diagram 

Requestor

Data Standards 
and Terminology
Subcommittee

(DSTS)

Glossary Stewardship 
Group (NWCG 

committees
and subgroups)

Glossary Entry
(term and definition)

Internal Reviewers
(NWCG committees

 and subgroups)

NWCG Web 
Manager

 

Figure 3. Entities involved in creating, developing and maintaining an NWCG glossary entry 
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Workflow Diagram Key 
Workflow Object Definition 

Requestor  

A person (within NWCG or the public) that proposes the need for a 
new or revised glossary entry. 

Data Standards and
Terminology Subcommittee

(DSTS)  

A subcommittee within NWCG that assures all proposed changes to 
NWCG Glossary of Wildland Fire Terminology follow a standardized 
development process, are properly vetted, approved, and submitted 
for publication. 
 

Glossary Stewardship Group
(NWCG committees

and subgroups)  

An NWCG committee or subgroups assigned to develop a draft 
glossary entry and ensure consistency across agencies. 
 

Internal Reviewers
(NWCG committees 

and subgroups)  

Persons within the NWCG organization who review draft glossary 
entries and provide feedback. 
 

 
NWCG Web 

Manager  

Person responsible for maintaining the NWCG website. 
 

Figure 4. Workflow diagram key for entities involved in maintenance of the NWCG glossary
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Appendix A 

Glossary Entry Development Workflow 

Submit
Request

(Requestor)

Develop
Draft Glossary

Entry
(Glossary 

Stewardship Group(s))

Submit Request (New, Update, Remove, Other)

 Requestor goes to http://www.nwcg.gov/pms/pubs/glossary/request.htm and downloads
       NWCG Glossary Request.
 Requestor enters information.
 Requestor submits NWCG Glossary Request via email to BLM_FA_NWCG_Glossary@blm.gov.
 DSTS receives NWCG Glossary Request, sets status to “Received” in the DSTS Glossary Tracking Log.  
        If needed updates the NWCG glossary database. 

Assign Glossary Stewardship Group

 If a new glossary entry, the Data Standards & Terminology Subcommittee (DSTS) determines the 
       NWCG committee(s) or subgroup(s) best suited for stewardship – Glossary Stewardship Group.
 DSTS consults with the branch coordinators to review committee or subgroup roster to determine
       a Glossary Steward Point of Contact (POC).
 PMU updates the NWCG database with stewardship information.
 DSTS forwards completed NWCG Glossary Request via email to:
 Glossary Steward POC
 Program Management Unit (PMU)

 PMU updates the DSTS Glossary Tracking Log with Glossary Stewardship Group information, and
       sets status to “Assigned”.

Develop Draft Glossary Entry

 Glossary Steward POC manages the development of the glossary entry to the submitted request.
 Consults DSTS for support and guidance as necessary.
 Distributes NWCG Glossary Request to Glossary Stewardship Group.
 Makes assignments for drafting or information gathering.
 Sets the schedule for progress reporting and working meetings.
 Periodically informs DSTS of schedule and progress.
 When Glossary Stewardship Group determines that draft is ready for internal review the Glossary Steward 
        POC emails BLM_FA_NWCG_Glossary@blm.gov with the drafted glossary entry and any supporting 
        documentation.

Next Page

Assign Glossary
Stewardship Group

(NWCG DSTS)
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Glossary Entry Development Workflow (continued) 

Conduct Final
Review

(NWCG DSTS)

Conduct Final Review

 DSTS reviews final documentation from Glossary Stewardship Group.
 DSTS may contact Glossary Steward POC for questions or clarification.

 PMU updates the DSTS Glossary Tracking Log with review dates and sets status to “Final Review”.
 DSTS forwards NWCG Glossary Request via email to the PMU indicating the entry is approved and ready for 
        publishing.

Publish Glossary

 PMU updates DSTS Glossary Tracking Log to set status to “Approved”.
 PMU updates the NWCG glossary database, and creates a new version of Summary of Changes to the Glossary
        of Wildland Fire Terminology. This document identifies all the glossary entries (terms or definitions) that were
        added, changed or deleted between the current version most recently published, and the previous version.
 After the first of the year the PMU generates a new NWCG Glossary of Wildland Fire Terminology, 
        NWCG Web Manager posts both documents to http://www.nwcg.gov/.

Publish
Glossary

(NWCG Web 
Manager)

Conduct Internal Review

 DSTS updates NWCG Glossary Request, PMU updates the DSTS Glossary Tracking Log with review 
        dates and sets status to “Internal Review”, and updates the NWCG glossary database.
 DSTS works with PMU to produce an annotated summary of all glossary entries ready for review, 
        NWCG Proposed Glossary Changes for Review.
 DSTS emails from BLM_FA_NWCG_Glossary@blm.gov inbox all information needed for internal review to 
        NWCG committees and subgroups.
 Cover letter review instructions
 NWCG Glossary Entry Change Review Worksheet
 NWCG Proposed Glossary Changes for Review

 Reviewers submit completed NWCG Glossary Entry Change Review Worksheet via email to the DSTS at
        BLM_FA_NWCG_Glossary@blm.gov.
 PMU synthesizes all internal review comments received.
 PMU forwards comments via email DSTS and Glossary Steward POC(s).
 Glossary Steward POC manages the development of the response to comments.
 Consults DSTS for support and guidance as necessary.
 Distributes comment summary to Glossary Stewardship Group.
 Makes assignments for evaluating comments, formulating responses, and making changes to the draft 

glossary entry.
 Sets the schedule for progress reporting and working meetings.
 Periodically informs DSTS of schedule and progress.
 Glossary Steward POC emails DSTS at BLM_FA_NWCG_Glossary@blm.gov with Glossary Stewardship

Group response to comments.  DSTS reviews responses prior to sending to NWCG committees or 
subgroups that submitted comments.

 When Glossary Stewardship Group determines glossary entry is ready for final review the Glossary
Steward POC emails BLM_FA_NWCG_Glossary@blm.gov with final definition and any supporting 

       documentation.

Conduct Internal 
Review
(NWCG 

committees
 and subgroups)
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